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Objectives 

Upon completion of this lesson, you should be able to: 

 Identify the fundamental concepts of  

 word-processing software. 

 spreadsheet software. 

 presentation software. 

 database software. 

 graphics and multimedia software. 

 education and entertainment software. 

 Identify the types and purposes of utility programs. 

 Identify other types of miscellaneous software programs. 
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Words to Know 

 bitmapped graphics 

 cell 

 database 

 datasheet 

 field 

 multimedia 

 object 

 object linking and 
embedding (OLE) 

 presentation software 

 primary key 

 query 

 record 
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Cont. Words to know 

 spreadsheet 

 table 

 text editor 

 utility program 

 vector graphics 

 word-processing software 

 workbook 

 worksheet 
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Competencies 

6670-36: Identify the classes of software associated with information 
systems.  

6670- 56: Investigate the building stages of a computer.  

6670-57: Describe the importance of system maintenance and 
preventative measures, including the consequences of not taking 
preventive measures.  

6670-58: Install and configure hardware in a computer system.  
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6670-61: Install and configure anti-X software (e.g., anti-virus, anti-
spy ware, and anti-spam).  

6670-62: Identify basic problems associated with computer 
hardware, operating system, and application software.  

6670-63: Describe risk-mitigation techniques (e.g., policies, 
procedures, hardware, and software).  

6670-81: Explain the steps in a program life cycle. (optional) 

 

L7: Software Fundamentals 



Introduction to Lesson 

As you learned in Lesson 6, software is divided into two classes: 
system software and application software. System software 
consists of low-level programs that interact with the computer 
at a basic level and is discussed in detail in Lesson 8. In contrast, 
application software (also called end-user programs) includes 
programs such as databases, presentation software, 
spreadsheets, and word processors. Symbolically speaking, 
application software sits on top of system software because it 
cannot run without the operating system and system utilities. 
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 You can purchase application software as individual programs 
or as a suite. A suite generally contains the following four 
types of programs: word processing, spreadsheets, 
presentations, and databases. Some of the more popular 
suites are Apple iWork, Corel WordPerfect Office, Google 
Docs, Microsoft Office, Microsoft Works, and StarOffice. 
Some suites, however, do not include a database program, 
while others contain add-ons such as Talk and Calendar. 
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Word-Processing Programs 

Word-processing software is a widely used application program. 
Primarily, you use this software to create, edit, and print 
documents and then save the documents electronically. When 
creating a document, you can easily correct errors and modify 
data. In most word-processing programs, you can save the 
document in a variety of formats including a template, earlier 
versions of the program, Rich Text Format, and plain text 
format. 
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Microsoft Office Word (see Figure 7–1 ), one of the more popular 
word-processing programs, includes basic and sophisticated 
features for creating, editing, formatting, and producing 
documents. For example, it includes collaboration features that 
allow you to track the changes made by multiple users. 
Reviewers can insert their comments within a document. These 
features are very useful, particularly when two or more people 
are working on the same project or when instructors need to 
comment on a student's work. 
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Extra for Experts 

If your desktop contains a Word icon or an icon for another 
Office program, you can double-click the icon to start the 
program. 
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 Document window: Area where you type and work with a 
document 

 Help button: Opens a new window with a Search text box 

 Horizontal scroll bar: Used to move the page left and right 

 Office button: Located in the upper-left corner of the Word 
window, this button replaces the File menu 

 Quick Access Toolbar: Located in the title bar and contains a 
repository of the most-used functions; fully customizable 

 Ribbon: Panels that contain command buttons and icons 
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 Rulers: Show the positioning of text, tabs, margins, insertion point, and any 
other elements on the page 

 Scroll bars: Used to scroll vertically and horizontally through a document 
that is too large to fit in the document window 

 Status bar: Displays the number of the current page and the total number 
of pages in the document; also indicates the on/off status of Word features 
such as spelling and grammar checking 

 Title bar: Displays the name of the software program and the name of the 
document on which you are working; the default name of a document is 
DocumentX, where X is a number 

 View buttons: Used to switch among the following views: Print Layout, Full 
Screen Reading, Web Layout Outline, and Draft 
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The following are basic features in word-processing programs 
that automate the process of creating and editing professional-
quality documents: 

 Accessibility: Use keyboard shortcuts, size, zoom, color, and 
sound options 

 Copy and paste: Select and then duplicate a section of text 

 Cut and paste: Select and then cut (delete) a segment of text 
from one place in a document and then insert or paste it 
somewhere else within the same document or within another 
document 
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 Delete: Select and then delete characters, words, lines, or pages of text 

 File management: Access options so you can create, delete, move, save, 
and search for files 

 Font selection: Apply font size, font type, italics, underline, and bold 
properties to the text 

 Graphics: Insert pictures, clip art, shapes, SmartArt, WordArt, and a variety 
of other objects 

 Text insertion: Insert text anywhere in the document; the inserted text can 
be copied from another word-processing document, an e-mail message, a 
Web page, or other document type 

 Page size and size margins: Define various page sizes and margins; text 
automatically is readjusted to fit the page 
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 Print: Send a document to a printer to produce a hard copy 

 Search and replace: Search for a particular word or phrase; 
replace is used to have a word or selection of words replaced 
with another anywhere within the selection or the entire 
document 

 Word wrap: Automatically moves the insertion point to the 
next line when one line is filled with text; the text is 
readjusted if the margins are changed 
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Word processors that support these basic features generally are 
called text editors, whereas word-processing programs that are 
more robust support additional features. Some of these more 
advanced features are as follows: 

 Blogs: Publish blogs directly from the word-processing 
program. 

 Footnotes: Automate the numbering and placement of 
footnotes. 

 Headers and footers: Specify custom text at the top and 
bottom of a page. 
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 Macros: Create a series of keystrokes that represent a series of commands. 

 Merge: Merge text from one file into another; useful for generating such 
documents as mailing labels and then merging them with a form letter. 

 Page numbering: Number pages in the format and position you specify. 

 Reference tools: Access a variety of reference tools such as a spell checker, 
research, thesaurus, and a language translator. 

 Windows: Display and edit two or more documents on the same screen. 

 WYSIWYG: Work with the document on the screen as it will look when 
printed; stands for "what you see is what you get." 
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Microsoft Word also provides other options that you can adjust 
and configure to suit your working style. You can display these 
options by clicking the Office button and then clicking the Word 
Options button at the bottom of the menu. Figure 7–2 shows an 
example of options you can modify through the Microsoft Word 
Options dialog box. In this figure, the Proofing category is 
selected. 
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Spreadsheet Concepts 

A spreadsheet is a row-and-column arrangement of data. You 
use electronic spreadsheet software such as Microsoft Office 
Excel to evaluate, calculate, manipulate, analyze, and present 
numeric data. Calculations are updated automatically, which 
makes this type of software very effective for tasks such as 
preparing budgets, financial statements, payrolls, and sales 
reports, and for managing orders and inventory. You can also use 
spreadsheet software to make forecasts and identify trends. 
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A spreadsheet (see Figure 7–3) looks much like a page from a 
financial journal. It is a grid with columns and rows. The rows 
and columns can contain text, formulas, and numbers (values). 
This grid in Excel is referred to as a worksheet. The terms 
spreadsheet and worksheet are used interchangeably. When you 
start Excel, you open a file called a workbook. Each new 
workbook comes with three worksheets, like pages in a 
document. 
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Figure 7-3 
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As shown in Figure 7–3, the columns are identified by letters of the 
alphabet, and the rows are identified by numbers. The point at which 
a column and a row intersect or meet is called a cell. Each cell has a 
name, called the cell reference (or cell address), which is represented 
by the column letter and the row number. For example, the first cell in 
a worksheet is cell A1. It is located in column A and in row 1. The active 
cell is the cell in which you are working currently and is surrounded by 
a thick border. Note that cell A1 is the active cell in Figure 7–3 (as 
indicated in the Name box) and that 26 rows and the columns A 
through O are displayed.  
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Some worksheets, however, contain thousands of columns and 
over a million rows; therefore only a small portion of the 
worksheet is displayed at one time, as seen in Figure 7–3. 
Individual worksheets are stored within a workbook. By default, 
a workbook contains three worksheets named Sheet1, Sheet2, 
and Sheet3, as shown on the sheet tabs at the bottom of the 
window. ( Sheet is another word for worksheet.) 

 

L7: Software Fundamentals 



The basic features supported by most spreadsheet programs are 
as follows; many of these features are the same or similar to 
those contained in word-processing programs: 

 Accessibility : Use keyboard shortcuts, size, zoom, color, and 
sound options. 

 Copy and paste : Select and then duplicate a section of text, a 
formula, a number, or other data. When a number or formula 
is copied from one cell and then pasted into a new cell, the 
spreadsheet program automatically readjusts the formula 
based on the new location. 
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 Cut and paste : Select and then cut (delete) a segment of text, a 
number, a formula, or other data and then insert or paste it 
somewhere else within the same document or within another 
document. If a formula is part of the selection, it is readjusted 
automatically to accommodate the new location. 

 Data filtering : Locate certain records in a spreadsheet based on 
selected criteria and then display those selected records. 

 Delete : Select and then delete numbers, text, formulas from cells, 
charts, and so on. 

 File management : Create, delete, move, save, and search for files. 
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 Font selection : Apply font size, font type, italics, underline, 
and bold properties to the data. 

 Formulas : Use a variety of formula options, including 
AutoSum, Financial, Logical, Math and Trig, and Statistical. 

 Graphics : Insert illustrations, images, SmartArt diagrams, 
symbols, special characters, and a variety of graph types into 
the spreadsheet. 

 Headers and footers : Specify custom text at the top and 
bottom of a page. 
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 Insert data : Insert data anywhere in the spreadsheet; the 
inserted data can be copied from another spreadsheet, an e-
mail message, a Web page, or other document type. 

 Macros : Create a series of keystrokes that represent a series 
of commands. 

 Merge : Merge a selection of cells or split merged cells; this is 
also used to merge copies of a shared worksheet. 

 Page numbering : Number pages in the format and position 
you specify. 
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 Print : Send a document to a printer to produce a hard copy of the 
worksheet or of the worksheet and chart. 

 Search and replace : Search for a particular word, phrase, formula, and so 
on; use replace to have a single selection or multiple selections of text or 
formulas replaced with another anywhere within the selection or the 
entire document. 

 Reference and editing tools : Use a variety of built-in editing tools such as 
a spell checker, thesaurus, grammar checker, and translate tools. 

 Windows : Display and edit two or more documents on the same screen. 

 WYSIWYG : Work with the document on the screen as it will look when 
printed; this stands for "what you see is what you get." 
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The appearance of the spreadsheet is almost as important as 
the accuracy of the data it contains. You can use formatting to 
emphasize specific entries, enhance the appearance of the 
spreadsheet, and make the information easier to read and 
understand. In Figure 7–4, you can see how formatting called 
cell styles and themes can affect the appearance of the data. 
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Figure 7-4 



In Step-by-Step 7.1, you start Excel and review the commands 
contained on the Page Layout tab of the Excel Ribbon. 
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Step-by-Step 7.1 

1. Start Excel by clicking the Start button on the taskbar, pointing to All 
Programs, clicking Microsoft Office, and then clicking Microsoft Office 
Excel 2007. 

2. Click the Page Layout tab on the Ribbon (see Figure 7–5). 

 

 

 

3. Review the five groups of commands on the Page Layout tab (Themes, 
Page Setup, Scale to Fit, Sheet Options, and Arrange). Use your word-
processing program and summarize the features provided within each of 
these groups. Submit your summary to your instructor. 

4. Close all open windows. 
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Presentation Concepts  

Presentation software is a computer program you use to 
organize and present information, normally in the form of a 
slide show. Through the use of sequential slides enhanced with a 
variety of special effects such as animation, text, graphics, and 
other features, a presentation is an effective and professional 
way to communicate topics and ideas. In addition, presentation 
software provides options for generating notes for the presenter 
and handouts for the audience. Equipment requirements for the 
presentation include a projector and computer (see Figure 7–6). 
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Besides being excellent for creating on-screen shows, 
presentation software is also useful in the following scenarios: 

 Self-running presentation : Job fairs, demonstrations, and 
conventions are a few examples of where you might see a 
self-running presentation. When the presentation is 
completed, it automatically restarts. 

 Online meetings : Using programs such as PowerPoint with 
Windows Meeting Space makes it easy to set up a meeting 
and share documents, programs, or your desktop with up to 
10 people. The participants can be located in the same city, 
state, or even another country. 
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 Presentation broadcasting : You can use the Web to 
broadcast your presentation to locations all over the world. 

 Web presentation : You can save a presentation as a Web or 
HTML document and upload it to your organization's Web 
site or to your own personal Web site. 

 Overhead transparencies : If you do not have access to a 
computer and projector for your presentation, you can create 
and print either black-and-white or color transparencies. This 
requires using plastic transparency acetate sheets in your 
printer. 
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 35-mm slides : Each screen can be saved as a separate slide and 
then converted to 35-mm slides. 

 Audience handouts : Printed handouts support your presentation. 
Smaller versions of your slides can be printed two, three, six, or nine 
to a page. 

 PDF document : Portable Document Format (PDF) is a common 
format for sharing documents online and through other channels. 

Several software companies produce presentation graphics programs. 
Some of the more popular of these include Microsoft Office 
PowerPoint—both Macintosh and Windows versions—Corel 
Presentations, and Open Office. 
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Microsoft PowerPoint comes with a variety of designs, called 
themes, that you can apply to a presentation. A theme is a 
predesigned set of fonts, colors, lines, fill effects, and other 
formatting. PowerPoint also provides transitions, which are 
animated effects that play between slides. In Step-by-Step 7.2, 
you start PowerPoint and then review the themes and 
transitions. 
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Step-by-Step 7.2 

1. Start PowerPoint by clicking the Start button on the taskbar, 
pointing to All Programs, clicking Microsoft Office, and then 
clicking Microsoft Office PowerPoint 2007. 

2. Click the Design tab on the Ribbon (see Figure 7–7). 

 

L7: Software Fundamentals 



3. Move the mouse pointer over each theme in the Themes group to view a 
preview and the name of the theme. Click the More button to display 
additional themes in the Themes gallery (see Figure 7–8). Click a theme to 
apply it to the slide. 

 

 

 

 

4.  Click the Animations tab. Move the mouse pointer slowly over each of the 
five animated transitions in the Transitions to This Slide group. Note that if you 
rest the pointer on a transition, the name of the transition is displayed. 
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6. Click the More button to display the Transitions gallery. 

7. Use your word-processing program to answer the following 
questions: 

 Which theme would you select and why? 

 Which special effect would you use?   

 Would you use the same design and transition on each slide? 
Why or why not?   

 Submit your assignment to your instructor. 
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Extra for Experts 

Use photos, clip art, and graphics instead of words for a more 
powerful presentation. 
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Effective Presentation Guidelines 

You can use presentation tools to make any presentation more 
effective and interesting. However, be cautious! Presentation 
programs contain many features and many options, so it is 
sometimes difficult to avoid getting carried away. Often, the 
first-time user is tempted to add distracting sounds, animations, 
and excessive clip art to each slide. Before you create a 
presentation, therefore, you need to plan and outline the 
message that you want to communicate. As you develop the 
outline for your presentation, consider your audience and 
determine the presentation's purpose, the location in which it 
will be given, and the equipment you will need. 
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Follow these guidelines to create an effective presentation: 

 Keep the text simple—use the "6 by 6 rule," which is six lines of 
text, six words per line. 

 Use no more than 50 words per slide, including titles and subtitles. 

 Do not clutter your slide with large paragraphs displayed in a small 
font size. Use one-sentence comments and fill in the details orally. 

 Use bullets, not numbers, unless providing specific step-by-step 
instructions. Bullets indicate no significant order, while numbers 
indicate rank or sequence. 
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 Cover one topic per slide. 

 Use readable typefaces and fonts. Use serif fonts for body 
text and sans serif fonts for titles. 

 Choose color carefully. 

 Use simple tables to present numbers. 

 Add clip art sparingly and only where appropriate. 

 Don't try to dazzle your audience with an overabundance of 
graphics, sound, transitions, and other effects. 
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Technology Careers: Presentation Expert 

Presentations are an organization's most direct communication 
effort. Many times, a presentation can make or break a sale or 
prevent a company from landing that big contract. As more and 
more employees are using computers and presentation 
programs, companies are beginning to realize the importance of 
this media. 
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A growing trend in large companies is to hire a presentation 
expert to oversee the creation and delivery of presentations 
within the organization. Depending on the size of the company 
and the number of presentations required, this person might 
work alone or work as part of a media department. The media 
department generally functions as a service bureau for the rest 
of the company. Presentation managers might also be 
responsible for design. They must stay updated and aware of 
technological advances in the areas of multimedia. This position 
will most likely require additional education such as workshops, 
conferences, and classes. 
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Many large companies have a standard set of master slides and 
templates. All employees are expected to use these standards. 
The presentation manager might be responsible for creating 
these masters and templates and might even be responsible for 
teaching physical presentation delivery skills or coaching 
frequent speakers. 
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Because there are no certifications or degrees for presentation 
managers, many people employed in this field have graphics 
design and/or Web design backgrounds. They may or may not 
have a 4-year degree. It is not unusual to find someone with a 
community college 2-year degree in design or someone with 
design certifications employed in this type of job. 

Salaries are varied and can range from as little as $20,000 to as 
much as $80,000 or more. 
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Database Concepts 

Effective information management is the core of a successful 
business or organization and is important in your personal life. 
Data is unorganized text, graphics, sound, or video. Information 
is data that has been organized and processed so that it is 
meaningful and useful. Every organization and most individuals 
need a method to store data and convert it into accurate, 
relevant, and timely information when needed. 
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Database Software Defined 

A database is a collection of related information organized in a 
manner that allows for rapid search and retrieval. A database 
management system (DBMS) is a software program that is used 
to create, maintain, and provide controlled access to data. A 
database and spreadsheet are somewhat similar. Like 
spreadsheets, database tables are composed of rows and 
columns. Both programs enable you to organize, sort, and 
calculate the data. A database, however, provides additional 
comprehensive functions for manipulating the data. This lesson 
introduces you to some basic features of a database for 
entering, organizing, and reporting data. 

L7: Software Fundamentals 



Before you begin to design and develop a database, you should 
do some planning. Consider what data you will include and what 
information you want to create. After you have made these 
decisions, you are ready to begin creating your database. 
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Database Structure 

To use a database program effectively, you first need to 
understand some basic terminology. In Microsoft Office Access, 
a database can consist of one table or a collection of tables. A 
table is composed of columns and rows, referred to as fields and 
records in Access. Figure 7–9 shows a sample database table for 
customers of the Flower Store. The Flower Store provides 
wholesale products to florists, so its customers are small flower 
shops. 
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Following is a description of the three table components 
identified in Figure 7–9: 

The rows in the table are call records . Each record is a group of 
related fields, such as all of the information regarding each 
member in a membership database or each customer in a 
customer table. 

The columns in the table are called fields . Each field contains a 
specific piece of information within a record. In the table in 
Figure 7–9, for example, the Phone Number field contains the 
customer's phone number. 
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The Primary Key, which is assigned to a field, uniquely identifies 
each record in a table. It tells the database program how your 
records are sorted, and it prevents duplicate entries. In Figure 7–
9, the primary key is the Contact ID field. 

Microsoft Office Access is one of the most widely used database 
programs. When you start Access, the window you see is similar 
to other Microsoft Office 2007 applications in several ways—it 
displays a title bar, the Ribbon, and a status bar. Unlike Word, 
Excel, and PowerPoint, however, Access does not have a 
standard document view. The Access window changes based on 
the object you are using as you work with the database. 
Furthermore, many of the Ribbon buttons are unique to Access. 
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Using the data stored in the table, you can use Access to create 
the following objects: queries, forms, and reports. A query asks a 
question about the data stored in the table. The database 
program searches for and retrieves information from a table or 
tables to answer the question. You use forms to enter data in a 
table, and a report to print selected data. All of these objects—
tables, forms, queries, and reports—are stored in a single file, 
which is the database. 

After you create and save a new database, the next step is to 
add fields and then add data to the table. Tables are the primary 
objects in a database because they contain the data. Most 
databases contain multiple tables. 
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Creating a Table 

Access provides several ways to create a table, including the 
following: 

 Create a new database. 

 Add a table to an existing database using the Tables group on 
the Create tab. 

 Create a table based on a table template using the Tables 
group on the Create tab, selecting Table Templates, and then 
selecting an available template. 
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Creating a table is the first step in a three-step process and adding fields is the 
second step. The third step is to populate or add records to the table. When 
editing or adding records to a table, you can create and use a form or use 
Datasheet view. Views are formats used to display and work with the various 
objects. Access contains two basic views for working with tables: 

Design view:  

  Create a table, form, query, and report. 

 Datasheet view : Display a row-and-column view of the data in tables, 
forms, and queries; the table is called a datasheet and resembles an Excel 
worksheet. 

When you enter data in a cell, it is called an entry. To move from one cell to 
another, you can use the mouse to click in a cell or you can use the keyboard to 
navigate in a table. 
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Forms 

In addition to adding and viewing records in Datasheet view, you 
can also create and use a data-entry form. A form provides a 
convenient way to enter and view records in a table. When you 
create a form, you are adding a new object to the database. You 
can create the form manually or use the Form Wizard. The 
wizard asks you questions and formats the form according to 
your preferences. 
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Queries 

A query enables you to locate records that match specified criteria by 
providing a way for you to ask a question about the information stored in a 
database table or tables. The database program searches for and retrieves 
data from the table(s) to answer your question. Microsoft Access provides 
four query options: 

 Simple Query Wizard: Creates a select query from the selected fields. 

 Crosstab Query Wizard: Displays data in a spreadsheet format. 

 Find Duplicates Query Wizard: Locates records with duplicate field 
values. 

 Find Unmatched Query Wizard: Locates records in one table that have no 
related records in another table. 
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Suppose, for example, that you want a list of all customers 
within a specified zip code. When you create a query, you 
determine what fields you want displayed in the query results. 
Often, you only need to see certain fields in the query results 
instead of all the fields in the table. In the preceding example, 
for instance, you might want only the customer's last name and 
the zip code displayed. The order in which you select the fields 
determines the order in which the information is displayed in 
the query results. 

L7: Software Fundamentals 



Reports 

Another important feature of database management software is 
the ability to generate sophisticated reports that contain the 
contents of the database. A report is a database object that 
allows you to organize, summarize, and print all or a portion of 
the data in a database. You can create a report based on a table 
or a query. You can decide what formatting you want to use, 
such as headings, spacing, and graphics. After the report is 
generated, you can decide which records you want included in 
the report, you can sort the report, and you can insert a picture 
in the report. 
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Although you can produce a report manually, the Report Wizard, 
similar to the Query Wizard, provides an easy and fast way to 
design and create one. The wizard asks questions about which 
data you want to include in the report and how you want to 
format the data.  
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Online Databases 

Entrepreneurs looking to open an online business often want to 
find an Internet-based database program. Many Internet-based 
databases are dynamic and therefore provide the capability for 
the user to change the content and products frequently. 

Using an online database, you can insert new records and 
modify, delete, and search existing records. You can set up many 
online databases by uploading a CSV file from Microsoft Excel or 
Access. A CSV file is a comma-separated value file that can be 
exported from any spreadsheet or PC database software. 
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With some online databases, you can create a template for e-
mail marketing. Some other features of Web databases are as 
follows: 

 Create and update a contacts list. 

 Change photos frequently and update an online catalog. 

 Manage and keep your content current. 

 Use online documentation. 

 Generate formulas and calculated fields to automatically 
update your data. 

 Keep users up to date with the latest information. 

 Import and export information easily. 
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Graphics and Multimedia Programs 
Concepts  

You use graphics and multimedia programs to create a variety of 
illustrations and animation. Most graphics applications fall into 
one of two main categories: vector or bitmap graphics. A vector 
image consists of many individual objects with individual 
properties such as color, fill, and outline. Their resolution can be 
adjusted to the highest quality. A bitmap image is composed of 
pixels in a grid. Each pixel contains information about the color 
to be displayed. These images have fixed resolution and cannot 
be resized without losing image quality. Other types of images 
are identified in Table 7–1. 
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Table 7-1 Computer images 

Image Type Description 

FLV Adobe format for streaming Web video content 

GIF Image format for pictures with up to 256 distinct colors 

JPG File method for compressing graphics 

MOV File extension for digital video files in QuickTime format 

MP3 Compressed audio format 

PNG Bitmapped image format that uses lossless data compression 

Quick time Video and audio format that allows for the production of video 
and multimedia 

SWF Shockwave file format; supports exact positioning of graphical 
objects 

WAV Standard audio format 
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Drawing Programs 

A drawing program is a graphics program that is used for 
creating illustrations. The image is saved in a vector graphics 
format. This allows all individual parts of the picture to be 
moved, isolated, and scaled independently of the other parts. 
Examples of popular drawing programs are Adobe Illustrator 
and Corel Draw. 
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Paint Programs 

A paint program allows the user to simulate painting on the 
computer through the use of a graphics tablet or a mouse. The 
images are created with a matrix of picture elements (pixels) 
and are generated as bitmapped graphics. A program titled 
Paint is part of Microsoft Windows. Another popular paint 
program is Corel Painter. These programs use a variety of tools, 
such as a line tool, fill tool, shape, and curve. 
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Photo/Image Manipulation Programs 

You use digital editing software to edit images, photos, and 
logos. Adobe Photoshop is one of the more popular 
photo/image-editing programs. 

L7: Software Fundamentals 



Animation Programs 

You use animation software to create moving images and 3D 
graphics. Some of the more popular uses for these programs are 
online animations and game development. Adobe Flash, 3D 
Studio Max, and LightWave 3D are examples of this type of 
software. 
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Multimedia Programs 

Multimedia is defined as the use of text, graphics, audio, and 
video in some combination to create an effective means of 
communication and interaction. Some examples of how this 
software is used are games, interactive presentations, 
advertisements, screen savers, and interactive books. 
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Education and Entertainment Programs  

A wide variety of educational programs are available for children as young as 
1 year old, as well as software programs for ages up to adult. Many of these 
programs apply an entertainment motif to the software. The following 
describes this type of software: 

 Computer-based training (CBT) : Web based and/or computer-based 
training programs 

 Computer games : Single-user and multiuser games; combines an 
educational component with a game format 

 Audio and video : Software applications used to play audio and video; 
Media Player is bundled with Windows 

 Virtual reality : A technology that lets users interact with a computer-
simulated environment 
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Utility Programs 

Utility programs help you perform computer housekeeping 
chores. You use these programs to complete specialized tasks 
related to managing the computer's resources, files, and so on. 
Some utility programs are part of the operating system, and 
others are self-contained programs. Some examples of utility 
program functions are the following: 
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 File compression programs : Compress a file or files to reduce 
the amount of disk space it requires. WinZip is one of the 
more popular programs. Microsoft Windows also contains a 
compression utility. 

 Antivirus, antiadware, and antispyware programs : Use these 
types of software programs to protect against viruses, 
remove spyware, and prevent adware from playing or 
downloading advertisements. 
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 Defragmentation : Reduce the amount of fragmentation by 
organizing the contents of the disk to store the pieces of 
each file contiguously. 

 Backup program : Create a copy of data on a drive; you 
should back up your data files on a regular schedule. 

 Single-purpose tools and accessories : Use widgets or 
gadgets, mini-applications that can access online services or 
information such as the weather, or to provide a desktop 
calculator or clock. 
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Miscellaneous Software  

In addition to the software programs described, the following are 
other types of software: 

 Financial and accounting programs : Prepare financial statements 
for stockholders, employees, banks, and owners. 

 Electronic mail : Send and receive messages on the Internet or 
through company or individual networks. 

 Chat, messaging, and instant messaging software : Communicate 
in real time over the Internet by exchanging text messages. 

 Web browser : Visit Web sites using programs such as Internet 
Explorer or Firefox to browse the World Wide Web. 
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 Computer-aided design (CAD) : Design houses, buildings, 
airplanes, and so on; includes ability to view a design from any 
angle and to zoom in and out. 

 Project management : Plan, organize, and manage resources of 
the goals and objectives of a specific project. 

 Groupware : Participate as a member of a workgroup attached to a 
local area network to organize your activities; also called 
workgroup productivity software. 

 Web conferencing : Attend online meetings, share desktop 
presentations, and use VoIP, whiteboard, and chat, among other 
features. Some of the more popular programs are Adobe Connect 
Pro, Microsoft Office Live Meeting, and GoToMeeting. 
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 Integrated programs : Use programs such as Microsoft Office 
or Adobe Design, which contain a collection of programs 
within a single suite. 

 Specialized software : Programs such as airline reservation 
systems, manufacturing-plant automatic/process control, 
sales force/customer service automation, and school 
information management are used for specific activities. 
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Selecting Software 

 When selecting a software product, it is important to select a 
product that is appropriate for the task. You can use Microsoft 
Word, for example, to integrate a variety of extra features in 
addition to creating general text documents. For example, you can 
create tables using Microsoft Word; however, you can also create 
tables through a spreadsheet program such as Microsoft Excel or 
through a database program such as Microsoft Access. The end 
result needs to be examined to determine which of the three 
programs would be more appropriate for creating a table. 

 A second example of incorrectly selecting software is using word-
processing software to keep copies of financial records when a 
spreadsheet or an accounting program would be a better choice. 
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Software Integration 

As indicated previously, you can use individual application programs, 
such as those in Microsoft Office, to perform common tasks in the 
workplace, in education, and for personal use. In addition to 
producing individual documents with these applications, you can also 
integrate data from one program into the other programs. In this 
context, an object is the data or information that you want to share 
between the programs. Microsoft Office, for example, provides three 
methods for inserting objects from one Office document into another 
Office document: copying and pasting, embedding, and linking. Each 
method has advantages and disadvantages. 
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The copy-and-paste process between documents is similar to 
copying and pasting text or other objects within a single 
document. Assume that you have a chart or worksheet in Excel 
and you would like to add a copy of it to a Word document. In 
the Excel document you select and copy the content. Next, you 
open a Word document, click the location where you want to 
paste the copied data and then click the Paste button. 
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Extra for Experts 

In addition to embedding and linking Microsoft Office files, you 
can also link a variety of other files, including Adobe and Paint 
Shop Pro files, video clips, wave sounds, media clips, and others. 
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Object linking and embedding (OLE) is a technology developed 
by Microsoft that lets you create a document or object in one 
program and then link and/or embed that data into another 
program. You can embed or link all or part of an existing file. For 
example, you can create a form letter using Microsoft Word, link 
it to an Access database file that contains a list of names and 
addresses, and then merge the form letter with the names and 
addresses. 
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Keeping data current, however, can be an issue if the 
information changes often. A linked object, on the other hand, 
retains a connection to the original file, and the source 
document displays a representation of the linked data. Any 
changes made to the source file are reflected in the linked 
object. Assume that you have inserted a linked spreadsheet 
object into a PowerPoint document. If the spreadsheet data in 
the Excel program is modified, then the linked spreadsheet 
object in the PowerPoint document is also modified. 
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Linking is useful when information is maintained independently. You 
can also link an entire file to another program. For example, 
employee records are maintained by the personnel department. 
Other departments within the company use this data for sending 
mailings, creating interoffice documents, and so on. A link to the 
employee records would verify that the information was current. 

Internet applications can also interact with a user's desktop or 
network. Adobe Air applications, for example, can update 
themselves, interact with the system clipboard, use the file system, 
use native windows and menus, use a local SQL database, and store 
encrypted data. 
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Summary 

 How to use word-processing software to create, edit, and print 
documents and then save the documents electronically. When 
creating a document, you can easily correct errors and modify data. 

 A spreadsheet is a row-and-column arrangement of data. You use 
electronic spreadsheet software to evaluate, calculate, manipulate, 
analyze, and present numeric data. Calculations are updated 
automatically. 

 A database is a collection of related information organized in a 
manner that provides for rapid search and retrieval. You use 
database software to create, maintain, and provide controlled 
access to data. 
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Cont. Summary 

 A database can consist of one table or a collection of tables, which 
are composed of columns and rows, referred to as fields and 
records. The primary key, which is assigned to a field, uniquely 
identifies each record in a table. You can also create queries, forms, 
and reports using database software. 

 How to use graphics and multimedia programs to create a variety 
of illustrations and animation. Most graphics applications fall into 
one of two main categories: vector or bitmap graphics. 

 Educational programs include computer-based training, computer 
games, audio and video software, and virtual reality programs 
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Cont. Summary 

 Utility programs help you perform computer housekeeping 
chores such as managing the computer's resources and 
managing files. 

 Miscellaneous software includes programs such as e-mail 
applications, Web browsers, and project management 
software. 
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True/False 

1.  Word-processing software is one of the more widely used 
application programs. 

2. Macros are used to create a series of keystrokes that 
represent a series of commands. 

3. In Excel, individual worksheets are stored within a workbook. 

 4. In PowerPoint, a theme is a predesigned set of fonts, colors, 
lines, fill effects, and other formatting. 

 5. A database and a word-processing program have the same 
purpose. 
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Multiple Choice ( slide 1 of 3) 

1. The _____________________in a database table are called 
records.  

a) rows  

b) columns  

c) menus  

d) add-ons 

2. In a database program, a_____________________ enables you to 
locate records that match specified criteria.  

a) request  

b) query  

c) formula  

d) all of the above 
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Multiple Choice (2 of 3) 

3. A _____________________is an animated effect that plays between 
slides.  

a) vector graphic  

b) worksheet  

c) theme  

d) transition 

4. A(n) _____________________image is composed of pixels in a grid.  

a) access  

b) vector  

c) pixel  

d) bitmap 

L7: Software Fundamentals 



Multiple Choice (3 of 3) 

5. In a worksheet, the point at which a column and a row 
intersect or meet is called a(n) _____________________.  

a) field  

b) cell  

c) view  

d) object 
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Fill In the Blank 

1. _____________________programs help you perform computer 
housekeeping chores. 

2. _____________________software is used to design houses, 
buildings, and airplanes, and so on. 

3. A(n) _____________________is the data or information that you 
want to share between the programs. 

4. In OLE, _____________________is useful when information is 
maintained independently. 

5. A(n) _____________________provides a convenient way to enter 
and view records in a database table. 
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Projects 
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Project 7-1 

This lesson discussed the differences between types of application 
software. Complete the following: 

1. Use your word-processing program and create a table with four 
columns and five rows. 

2. Name the columns word processing, spreadsheet, database, and 
presentation. Bold the headings. 

3. In column 1, list four activities for which you would use a word-
processing program; in column 2, list four activities for which you 
would use a spreadsheet program; in column 3, list four activities for 
which you would use a database program; and in column 4, list four 
activities for which you would use a presentation program. 
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Project 7-2 

You can find many graphics programs to suit your needs. Complete 
the following: 

1. Use your favorite search engine to research the topic of graphics 
programs. Note the Web addresses of the most useful Web pages. 

2. Use your word-processing program to list the various programs and 
their cost or approximate cost. 

3. If you were going to select one of these programs to purchase, 
explain which program you would choose and why. Price is no object. 
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Project 7-3 

This lesson discussed widgets and gadgets. Complete the following: 

1. Use the Internet to research the terms widget and gadget. 

2. Locate a minimum of 10 widgets and gadgets. Note the Web 
addresses of the most useful Web pages. 

3. Use your word-processing program to write a short overview of each 
one. 
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Teamwork Project 
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This lesson discussed specialized software. Interview the 
technology specialist at your school or at the school district 
level. Ask such questions as what types of programs are used, 
how textbooks are ordered, what is used for class scheduling, 
how is the payroll handled, what other financial programs are 
used, and other pertinent topics. As a group, use the 
information you obtain to create a presentation to share with 
your classmates. 



Critical Thinking 

You have been selected as the lucky recipient of a $500 gift 
certificate that can be used to purchase integrated software. 
Review the various programs online and then select the one you 
would purchase. Use your word-processing program to describe 
the software and why you selected this particular program. 
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Online Discovery 

Defragmentation was discussed briefly in this lesson. Research 
defragmentation and expand the definition. Explain the 
advantages of defragmentation and describe how this process 
increases and improves startup times. 
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